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Chart Wizard: 
A graphical representation of a tabular database is called as a chart or a 
graph. A utility provided by MS Excel through which we can convert a 

tabular database into a chart in step by step procedure is called as Chart 
Wizard. To start Chart Wizard, follow the steps: 

Insert Chart 

Also we can find Chart Wizard button [ ] on Standard tool bar. We can 
simply start Chart Wizard by clicking on Chart Wizard button.  

Example: 
To create a chart, first of all we need to have a tabular database on MS 

Excel. The database should be well defined i.e. Field Name, Validation and 
Record Entry must be done with utmost care. Now select the database and 

click: 
 Insert Chart 

 

 
 

             (Database) 
 

 
 

 
(Wizard Step 1) 

 
In this wizard first of all select the Chart Type and then Chart Sub Type. 

Click on NEXT button to move further. Next Step of Wizard will appear on 
the screen. In this step you have to select the series (In Rows or in 

Columns). Also range of data can be decided. See Wizard step 2 

 
After selecting the series and 

data range click on NEXT 
button to move to the next 

step of the wizard. Here you 
have to put the Chart Title, 

Categories in X, Y and Z axis. 
After entering these details 

click on NEXT button to move 
to the next step of the wizard. 

 
(Wizard step 2) 
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Last and final step of wizard 
will appear on the screen. 

In this step you have to 
select the location of the 

chart (As Chart in a new 
sheet or as an object in 

existing sheet). After 
selecting the location click 

on FINAL button. Chart is 
ready. 

 
(Wizard Step 3) 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

(Chart) 

 

Chart Style & Sub Style: 

MS Excel provides different style of Charts such as Columns, Bars, and Pie 
etc. Each style has different patterns to display the charts in different 

styles. These patterns are known as Sub Style. (See Wizard Step 1) 
Chart Title: 

To name a chart, MS Excel provides a Box where we can input the title. 
This title appears on top of the chart when chart is ready. (See fig: Chart) 

Categories in X, Y and Z Axis: 
In a Chart we have to provide the name of Data to be shown on X Axis, Y 

Axis and Z Axis (in case of 3d chart). These names are indicated on the 
respective axis. Technically these names are known as Categories in X, Y 

and Z axis.  
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Legends: 

The graphics that are displayed on a chart are indicated on chart itself in 
colour code or patterns to identify the data. These indications are known 

as Legends. 
 

Cell Formatting: 
In MS Excel we can format a cell in reference with text formatting, Text 

Alignment, Font colour and Fill colour etc. MS Excel provides a Dialog Box 
which has different tabs to format the cell in many ways. Formatting a cell 

through this dialog box is known as Cell Formatting. 
To open Format Cell dialog box click the steps: 

Select the cell or cells and the click, Format  Cell 
Alternatively you can right click on the cell and then click on Format Cell 

option to open the dialog box. 

 
(Format Cell Dialog Box) 

Using the Tabs we can decide the data type, text alignment, font, border, 
pattern and protection for formatting. 

Note: For any kind of cell formatting, make sure that cell or cells are 
selected. 

Example: (Cell formatting for number) 
To format a cell to accept data as digit up to two decimal places, open the 

Format Cell Dialog Box, click on Number Tab and then in category select 
Number and finally type or select 2 in decimal places. Click Apply and the 

OK. Cell is formatted for number. 
Example: (Cell formatting for text alignment) 

To format a cell for alignment, first of all select the cell or cells and then 
open the format cell dialog box. Now select the Horizontal and Vertical 

alignment of the text. To accommodate all text in a column in multiple 
lines, click on “Wrap Text” Check Box. To accommodate all text in a 
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column in single line, click on “Shrink to Fit” Check Box. To merge more 

than two cells into one cell, click on “Merge Cells” Check Box. 
Example: (Cell formatting for Perpendicular and angular text alignment) 

Select the cell or cells and then open the Format Cell dialog box. In the 
dialog box click on “Perpendicular” text alignment option and then click 

“Apply” and then OK. Similarly to provide an angular alignment, type the 
angle in the given place (box) or drag the pointer to any angle. Now click 

“Apply” and then on “OK”. 
 

Data Sort, Data Filter and Advance Filter: 
Data sort, Data Filter and advance Filter are the utility for database 

handling provided by MS Excel for a quick and clear yet meaningful and 
worthy vision of only required data from the large database. 

 
Data Sort: 

Generally we accept and enter the data in haphazard way and it some 

times becomes troublesome to find any particular data or particular type of 
data. So, Data sort is a utility through which we can rearrange our 

database in an order arranged alphabetically or numerically in ascending 
or descending order. 

 
Data Filter: 

Data Filter is a utility of MS Excel through which we can extract out only 
the desired set of data that satisfies one or more conditions. After filtering 

the database now we get only the desired data and rest other data in the 
database remain hidden. 

 
Advance Filter: 

It’s a utility of MS Excel through which we can filter out the desired data 
from a database where the base of the filtration is the criteria which we 

provide for each column. The Advanced Filter command can filter a range 

in place like the AutoFilter command, but it does not display drop-down 
lists for the columns. Instead, you type the criteria you want to filter by in 

a separate criteria range above the range. A criteria range allows for more 
complex criteria to be filtered. 

Data sort, Data Filter (Auto Filter and Advance Filter) is explained in detail 
as under with the following database:   

   (Original Database) 
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Procedure to Data sort: 
 

 
(Sort Dialog Box)      (Sorted Database) 

 
For best results, the data range you sort should have column labels. Select 

the database to be sorted: 
1. Click a cell in the range you want to sort.  

2. On the Data menu, click Sort.  
3. In the “Sort by” and “Then by” boxes, click the columns (Fields) you 

want to sort.  
4. Select any other sort options you want, and then click OK. 

Note: To identify the header row make sure that option “My Data Range 
has header row” should be selected. 

Procedure to Data Filter: 
 

    
(Data with Auto Filter drop down button)  (Filtered Database) 

 
To filter a data base follow the steps: 

1. Click a cell in the range you want to filter.  
2. On the Data menu, click Filter and then Auto Filter.  
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3. You will get a drop down buttons on each columns, click any drop 

down button on the columns and you will get a list of data (records) 
of this column (field) properly arranged and without repetition.  

4. Click on any record and in the entire database only those records in 
all the columns will be seen which can satisfy the selected record. 

Similarly we can keep on filtering for more fields and so on. 
 

Procedure to Advance Filter: 
 

          
(Original Database with Criteria) (Advance Filter Dialogue Box) 

 

 
(Advanced Filtered Database According to the given criteria) 

 

First of all insert at least three rows on top of the database. Copy the 
header row and paste it on newly added top empty row. The next rows 

afterwards can be used to provide the criteria. 
Now type the criteria as per your requirement in the cells. Click any cell 

within the original database and follow the steps: 
Data Filter Advance Filter 

Dialogue box for advance filter will appear. In this dialogue box, list range 

and criteria range is to be input. Now click on OK Button. The original 
database is filtered and all those records which do not satisfy the criteria 

get hidden. 
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Page Setup: 

The activity that is done to setup the page so that we can get the print out 
of our sheet the way we want is called as Page Setup. Page setup 

procedure in Ms Excel is quite different from Page Setup in MS Word. Page 
Setup in MS Excel includes Paper Size, Margins, Header & Footer and 

Setup of sheet area.   
To Setup the page follow the steps: 

File  Page Setup the Page setup dialog box opens. 
 

 
Page Setup  (Tab - Page)       Page Setup  (Tab - Margin) 
 

Click on first tab “Page”. In this option you can select the page orientation 
i.e. Portrait or Landscape. Scaling to adjust the page percentage, Paper 

size etc. 
Click on second tab “Margin”. In this option one can type the Margins (Left, 

Right, Top and Bottom). Also, we can make the table setup to be appeared 
in the page at the horizontal or vertical center. 

 

    
Page Setup  (Tab – Header & Footer)  Page Setup  (Tab - Sheet) 
 

Click on tab “Header & Footer”. In this option we can apply the Header and 

Footer. You can use preset Header or Footer from their drop down buttons. 
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Also, we can customize Header & Footer by clicking on their respective 

buttons. Apart from typing the text, we can format and colour the text. 
Click on tab “Sheet”. In this option we can decide the area to be printed, 

rows to be repeated on every page and column to be repeated at left on 
every page. 

Example for print area: $A$1:$E$17 
Example for row to be repeated on every page: $A$1: $I$1 

Example for column to be repeated on left of every page: $A$1:$A$15 
Different Printing Options: 

To print a sheet, follow the steps: 
File  Print 

A dialog box to print the sheet will appear on the screen. In this dialog box 
we get the different printing options, such as: 

Print range: 

 All 
 Pages – From: _____ To: _____ 

 
Print What: 

 Selection 
 Entire workbook 

 Active sheet(s) 
 

Number of Copies: 
 1 or more 

Apart from using the printing options from Print dialog box, we can set or 
clear the print area using the following steps: 

File  Print Area  Set Print Area 

File  Print Area  Clear Print Area 

PivotTable:  

 Source data 

 Source values for summary 
 PivotTable report 

 Summary of source values  
A PivotTable report is an interactive table that quickly combines and 

compares large amounts of data. You can rotate its rows and columns to 
see different summaries of the source data, and you can display the details 

for areas of interest. 
Use a PivotTable report when you want to analyze related totals, especially 

when you have a long list of figures to sum and you want to compare 
several facts about each figure because a PivotTable report is interactive, 

you can change the view of the data to see more details or calculate 
different summaries, such as counts or averages. 

In a PivotTable report, each column or field in your source data becomes a 
PivotTable field that summarizes multiple rows of information.  
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To create a PivotTable report: 

Run the PivotTable and Pivot Chart Wizard (Data  Pivot Table). In the 
wizard, you select the source data you 

want from your worksheet list or external 
database.  

The wizard then provides you with a 
worksheet area for the report and a list of 

the available fields. As you drag the fields 
from the list window to the outlined areas, 

Microsoft Excel summarizes and calculates 
the report for you automatically. 

 

 
 

(A Pivot Report)   
Most commonly Pre Defined Functions: 

The most commonly used functions which are easily available on clicking 

on Sigma [ ] button on standard tool bar are as follows: 

 
SUM 

Average 
Count 

Max 
Min 

More Functions 
 

Apart from these functions we can get more functions as per our 
requirements by clicking on “More Functions” options. 

 

 
 

Pivot Table Field list to add the fields on desire areas. 
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Logical Operation: 

MS Excel has a smart feature to produce result by providing a Logical 
Program in our database. To obtain a logical result from a database 

through any logical program is called as Logical Operation. 
Example: 

 

   
    (Original Database)        (After Logical Operation) 

 
In the given database a Logical Operation is done on Field “Progress”  

where progress of the sales person is graded on the basis on the sales 
done by them. The logic says that the sales persons who achieved sales 

equal to or greater than 100000.00 should be graded as “excellent”, those 
sales persons who achieved sales equal to or greater than 50000.00 

should be graded as “Good” and rest all who could not achieved the sale 
even equal to 50000.00 should be graded as “Poor”. 

The logical formula should be: 
 

=IF(D2>=100000, "Excellent", IF(D2>=50000, "Good","Poor")) 
  

Various Data types: 

MS Excel supports different types of data format which are given as under: 
General 

Number 
Currency 

Accounting 
Date 

Time 
Percentage 

Fraction 
Scientific 

Text 
Special  

Custom 
We can configure columns or rows to accept any particular type of data to 

be entered. At any given instance we can convert any data type into any 

supported data type. 
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Protect Sheet, “Protect Work Book” and “Protect and Share Work 
Book”:  

Protect Sheet and Protect Work Book are the feature to safeguard our 
sheet or work book from being manhandled and trespassed or misuse. In 

fact we provide a password for protection. 
Procedure: Protect Sheet and Protect Work Book 

Switch to the worksheet you want to protect. 
Unlock any cells you want users to be able to change: select each cell or 

range, click Cells on the Format menu, click the Protection tab, and then 
clear the Locked check box. 

Hide any formulas that you don't want to be visible: select the cells with 
the formulas, click Cells on the Format menu, click the Protection tab, and 

then select the Hidden check box. 
Unlock any graphic objects you want users to be able to change. 

 

How? 
You don't need to unlock buttons or controls for users to be able to click 

and use them. You can unlock embedded charts, text boxes, and other 
objects created with the drawing tools that you want users to be able to 

modify. To see which elements on a worksheet are graphic objects, click 
Go To on the Edit menu, click Special, and then click Objects. 

Hold down CTRL and click each object that you want to unlock.  
On the Format menu, click the command for the object you selected: 

AutoShape, Object, Text Box, Picture, Control, or WordArt.  
Click the Protection tab.  

Clear the Locked check box, and if present, clear the Lock text check box.  
On the Tools menu, point to Protection, and then click Protect Sheet. 

Type a password (password: A way to restrict access to a workbook, 
worksheet, or part of a worksheet. Excel passwords can be up to 255 

letters, numbers, spaces and symbols. You must type uppercase and 

lowercase letters correctly when you set and enter passwords) for the 
sheet. 

In the Allow all users of this worksheet to list, select the elements that you 
want users to be able to change. 

Click OK, and if prompted retype the password. 
 

Note:  
1. The password is optional; however, if you don't supply a password, 

any user will be able to unprotect the sheet and change the 
protected elements. Make sure you choose a password you can 

remember, because if you lose the password, you cannot gain access 
to the protected elements on the worksheet. 

2. The same procedure can be used to protect a work book. 
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Share Work Book 

A shared workbook allows several people to edit simultaneously. It's 
particularly useful for managing lists (list: A series of rows that contains 

related data or a series of rows that you designate to function as a 
datasheet by using the Create List command.) that change frequently. 

For example, if the people in your workgroup each handle several projects 
and need to know each other's status, the group could use a list in a 

shared workbook where each person enters and updates a row of 
information for each project. 

 
Procedure: Share Work Book 

Creating a shared workbook 
The original author of a workbook prepares it to be shared by entering and 

formatting the data that needs to be present. The workbook is saved as 
shared, and put on a network share (not a Web server) available to the 

intended users. After the preparation of the work book click on Tools menu 

and then click on Share work Book. A Dialog Box appears. In this dialog 
box you have to click on Check Box that says, “Allow changes by more 

than one user at the same time. This also allows work book merging”. Click 
OK and now your work book is shared and more than one user can work 

simultaneously. 
Because some Microsoft Excel features can be viewed or used but not 

changed once the workbook is shared, you'll want to set up these features 
before you share the workbook. 

The following features can't be changed after a workbook is shared: 
merged cells, conditional formats, data validation, charts, pictures, objects 

including drawing objects, hyperlinks, scenarios, outlines, subtotals, data 
tables, PivotTable reports, workbook and worksheet protection, and 

macros. 
Make settings that affect all users when you share the workbook, you can 

customize some sharing features. For example, you can decide whether to 

keep track of changes for the default 30 days or for a longer or shorter 
amount of time. 

 
(Share Work Book Dialog Box) 
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Working in a shared workbook 

After you open a shared workbook, you can enter and change data as you 
do in a regular workbook. A few aspects are different from working in a 

regular workbook, however. 
Each time you save the shared workbook, you're updated with any 

changes that others have saved since the last time you saved. If you want 
to keep the shared workbook open to monitor progress, you can have 

Microsoft Excel update you with changes automatically, at timed intervals 
that you specify, with or without saving the workbook yourself. 

When you save changes to a shared workbook, another person who's 
currently editing the workbook might have saved changes to the same 

cells. In this case, the changes conflict, and a conflict resolution dialog box 
appears that allows you to decide whose changes to keep. 

Excel saves a custom view of the shared workbook for you that include 
things like which worksheet you have displayed and your zoom settings. 

By default your view includes any filter and print settings you make, or you 

can specify that you want to use the original filter and print settings. Each 
time you open the shared workbook, Excel displays it with your view in 

effect, so that each user can have his or her own settings. 
 

Goals seek: 
Goal Seek is part of a suite of commands sometimes called what-if analysis 

tools  
 

What-if analysis: A process of changing the values in cells to see how 
those changes affect the outcome of formulas on the worksheet.  

For example: Varying the interest rate that is used in an amortization table 
to determine the amount of the payments. 

 
When you know the desired result of a single formula (formula: A 

sequence of values, cell references, names, functions, or operators in a cell 

that together produce a new value. A formula always begins with an equal 
sign (=)) but not the input value the formula needs to determine the 

result, you can use the Goal Seek feature available by clicking Goal Seek 
on the Tools menu. When goal seeking, Microsoft Excel varies the value in 

one specific cell until a formula that's dependent on that cell returns the 
result you want. 

 
Example: Simple Interest Calculation 

Create the table and use the formula wherever required. Here in cell D2 we 
have used the formula to calculate the simple interest as: 

=(A2*B2*C2)/100 
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(Original Data Table)     (Use of Goal Seek 
option) 

 

Now if you wish to get Simple Interest as Rs. 40000 by changing cell of 
Time i.e. C2, you have to click on Tools menu and then point to Goal Seek. 

A dialog box like above will appear. In this dialog box put the cell 
addresses to set the cell in “Set Cell” and “By changing Cell” (viz. Set 

CellD2,By Changing Cell- $C$2). Click OK to get the value. 
 

    
 

 
(Data after use of Goal seek Command) 

Scenarios: 
Scenarios are part of a suite of commands sometimes called what-if 

analysis tools. A scenario is a set of values that Microsoft Excel saves and 
can substitute automatically in your worksheet. You can use scenarios to 

forecast the outcome of a worksheet model. You can create and save 

different groups of values on a worksheet and then switch to any of these 
new scenarios to view different results. 
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Creating scenarios: For example, if you want to create a budget but are 

uncertain of your revenue, you can define different values for the revenue 
and then switch between the scenarios to perform what-if analyses. 

 

                       
 
In the example above, you could name the scenario Worst Case, set the 

value in cell B2 to 50,000, and set the value in cell B3 to 13,200. 
You could name the second scenario Best Case and change the values in 

B2 to 150,000 and B3 to 26,000. 

      
 

 
 

 
 

 
Scenario name (Worst) with changing cell 

range  
 

 
 

 
 

(Scenario Manager) 

Scenario values for worst 

 
Scenario name (Best) with   Scenario values for Best 

changing cell range  
 

Export & Import of Tally Data: 
It is important to have Tally Data in other formats too, so that we may use 

the same on different software for different other purpose. Similarly 
sometimes while working on Tally we require external data. Therefore to 
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and fro motion of data is frequently done. This outflow and inflow of data is 

known as Data Export and Data Import respectively. 
Export of Tally Data: 

Open Tally and open your company. Now open the report, data of which 
you want to export. 

 

 
Click on Export button or press Alt + E. A new screen will appear which will 

guide us about data export. Here you have to select the data format and 
file name. You also can provide some additional information about the data 

type. Finally accept the options and Data is exported. 
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Import of Data in Tally: 

To import data into Tally, first of all make sure that the external data 
should be of XML format. 

In “Gateway of Tally” screen select and enter “Import of Data” option. A 
new screen will appear where you are supposed to select and enter 

“Master” or “Voucher” to be imported. Again a new screen appears. In this 
screen you have to input the path and file name. finally accept the option 

and Data is imported into Tally. 

 
(Data import screen) 

 

Backup & Restore: 
As we make the voucher entries for transactions in Tally, the information 

of the transactions are converted into special kind of data. So, the 
complete accounting done on Tally becomes a collection of Data. This 

collection of Data is very important and no one wants it to be corrupted or 
destroyed. Still, one can not be sure about the integrity of the Data. 

Moreover, computer is a machine and like every machine, it too has a 

possibility of breakdown. If the storage media of computer system has 
some kind of breakdown, our data is at stake. We can not prevent the 

damages but we can at least keep a copy of our important tally data 
separately so that if in case our data is lost we can get it back from the 

copy of data which we have already taken and stored. The process of 
copying the Tally data is known as Backup whereas getting back the Tally 

data from its copy is called as Restoration.  
Tally provides us the facility to take the backup and restore the tally data 

in “Company Info screen” as options. We can activate them by selecting 
and entering them. 

 
(Company Info screen showing Backup & Restore options) 
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Backup: 

Tally has a flexible back-up mechanism where in you can take a backup of 
the data from virtually any storage medium into any other medium. 

The more commonly used media are floppy drive, hard disk drive, zip 
drive, tape drive, etc - installed either locally or on a network. In the 

backup screen, the source of the backup and the destination of where it 
has to be stored have to be given, Tally will do as required. 

 
The Backup screen appears as: 

 

 
 
How to take Backup: 

1. Start Tally - If the Company Information screen is loaded first – 
there is a menu option "Backup". Select this to get the "Select 

Companies to Backup" screen. However, if the Gateway of Tally 
Loads – use Alt+F3 to get the option Backup. Note that this option is 

available only on the Company Information screen 
2. To change either the source or the destination paths, use the 

Backspace key and change the path as required. Let us say we want 
to backup the data to a directory Tally backup in the D Drive – 

change the path to D:\Tallybackup and choose the companies as 
required. Incase we want to take a backup onto another person's 

system – the path will be 
\\machinename\\drivename\directoryname.The process of backing 

up data begins when at least one company is selected for the same. 
To stop selecting companies, select the option "End of List" which 

appears at the top of the selection list. Note: This option appears 

only after one company is selected for backup. 
3. The backup file is stored as TBK500.001. If the backup is taken in a 

medium likely to extend more than one – for example, floppy, then 
the extension digits (001, 002) will be stored accordingly. 

Restore: 

Restore literally means 'to bring back'. Similar to backing up of data, Tally 
allows restoring of data from any medium into any other storage medium. 

In Tally's context restore means – we have a Tally backup and we wish to 
work on the data backup instead of the current data – this can be achieved 

by simply restoring from the existing data backup. 

The Restore screen appears as: 
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How to restore data from backup: 

 
1. Start Tally If the Company Information screen is loaded first – there 

is a menu option "Restore". Select this to get the "Select Companies 
to Restore" screen. However, if the Gateway of Tally Loads – use 

Alt+F3 to get the option Restore. Note that as in the case of backup 
- this option is available only on the Company Information screen. 

2. The Source and Destination paths displayed here are those that were 
used last. 

3. The source field has to have the appropriate path from which we 
intend to bring back the previous data. Accepting the path will read 

the contents of the particular file and will then display the list of 
companies available. 

4. Select as required and restore the data accordingly. 
 

 


